ARDUINO!

Was ist ein
ARDUINO ?

Eine quelloffene Elektronik-
Prototypen-Entwicklungs-
Plattform.

Aber was soll das bedeuten?

Quelloffene -
Elektronik -

Prototypen -

Plattform -

Die Hard- und Softwarekomponenten eines Produkts diirfen kostenlos genutzt,
verdndert und weiter verbreitet werden.

Technologie, welche sich die physikalischen Eigenschaften von Elektronen
in Leiterbahnen zu Nutze macht.

Probemodell eines Gerdts fiir die Serienproduktion.

Eine Ansammlung von passender Hardware und Software, die einem das
Ausfiihren eigener Programme ermdglicht.
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Steckbrett

Ein Arduino ist ein Mikrocontroller, ein sehr kleiner Computer, den man dazu bringen kann, auf Geschehnisse zu
reagieren. Er kann Sachen messen (z.B. wie hell ein Raum gerade ist). Und er kann dann andere Dinge dazu bringen
auf diese Verdnderungen zu reagieren. (z.B. der Raum wird dunkel und eine LED geht an).
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Bei PCs sind Maus und Tastatur
die klassischen Eingabegerdte.
Die Bildschirmanzeige ist eine

Ausgabemethode.
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Oder er konnte auf so einfache Sachen wie
das Umlegen eines Schalters reagieren.

Mikrocontroller arbeiten wie Computer mit Ein- und Ausgaben.
Eingaben kdonnen vom Benutzer gemacht werden oder aus der
Umgebung abgelesen werden. Ausgaben konnen Warntaone sein,

mit denen auf die gesammelten Informationen reagiert wird.
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Auf Druck
reagierender
Widerstand
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Tastschalter
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Gleichstrom-Motor

Einen Schalter oder einen Messfiihler kann man als
Eingabegerdt fiir den Arduino nutzen.

Jedes Geradt, welches man an- und abstellen kann, ware
als Ausgabegerdt geeignet. Man kdnnte einen Motor
oder sogar einen Computer verwenden.

Was ist der Unterschied
zwischen digitalen und
analogen Ein- und
Ausgdngen?

Eingdnge und Ausgdnge konnen digital oder analog sein..
Digitale Informationen sind bindr. Wahr oder Falsch.
Analoge Informationen sind kontinuierlich und haben
unendlich viele Zwischenstufen

Digitale Informationen
sind diskret und
endlich. Sie konnen
sich nur in zwei
Zustdnden befinden: 1
oder O, An oder Aus.

Analoge Informationen
sind kontinuierlich. Sie
konnen eine unendlich
groBe Anzahl
verschiedener Werte
annehmen.
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Ein Tastschalter ist d}giTal. Ein Messfiihler ist analog.
Die Anzahl der Zwischenstufen des Fihlers wird

jedoch durch die Umwandlung in digitale Daten endlich.




Spannung?
Stromstadrke?
Widerstand?
Das Ohmsche
Gesetz?

Bevor wir den Arduino anschliefen
sollten wir uns noch mit weiteren
Begriffe und Prinzipien befassen,

Spannung (V)

ist eine
Masseinheit fiir
elektrisches
Potenzial.
Gemessen wird
sie in der
Einheit Volt [V].

Stromstdrke (T)

Stromstarke ist
die Flussmenge
durch ein
leitendes
Material. Sie
wird in Ampere
[A] gemessen.

Widerstand (R)

misst wie stark
sich ein
leitendendes
Material dem

elektrischen Fluss

entgegenstellt.
Gemessen in
Ohm [Q].

die uns zeigen, wie Elektrizitdt und
somit Elektronik funktioniert.

Elektrizitat ist der Fluss von Energie durch ein leitendes Material.

Die Flussgeschwindigkeit wird durch
die Spannung bestimmt.

Widerstand ldsst Fluss zu

SN

oder behindert ihn.

Die Menge des Flusses durch die

Leitung ist die Stromstdrke.
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Die Wasser-Analogie wird hdufig genutzt, um die Begriffe zu erkldren.




Das Ohmsche Gesetz

Stromstdrke = Spannung / Widerstand
(I=U/R)

Widerstand = Spannung / Stromstdrke
(R=U/TI)

Spannung = Widerstand * Stromstdrke
(U=R*TI)

Es gibt einige Zusammmenhdnge zwischen Spannung,

i

Ein Beispiel: Erhoht man

Stromstdrke und Widerstand, die vom deutschen den Widerstand, so Erhéht man das Potenzial,
Physiker Georg Ohm entdeckt wurden. fliesst weniger Wasser so fliesst mehr Wasser.
Lampe
| ' — Gleichstrom-
Schalter — quelle

Schauen wir uns nun eine einfache Schaltung an. Jede
Schaltung ist ein geschlossener Kreislauf, der eine
Energiequelle (Batterie) und eine Last (Lampe)
beinhaltet. Die Last wandelt die Energie in Licht. Ein
Schalter wurde hier auch verbaut.
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Dies ist der Schaltplan der einfachen Schaltung. Die
Schaltung wird hier reprdsentiert, indem Symbole
anstatt der Komponenten gezeigt werden. Wenn der
Schalter geschlossen wird, fliesst Strom zwischen den
Polen der Energiequelle und erleuchtet die Lampe.
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Jetzt wo wir die Grundsdtze der
Elektrizitdt aufgefrischt haben
konnen wir uns wieder dem
Arduino zuwenden.

Es gibt zwei Arten von Schaltungen. Gleichstrom- und
Wechselstromschaltungen. Bei einer Gleichstrom-
Schaltung fliesst der Strom immer in eine Richtung. Bei
einem Wechselstromkreis kehrt sich der Stromfluss
regelmdBig in die entgegengesetzte Richtung. Wir
interessieren uns nur fur G%eichsfr'omschalfungen.

Der Arduino endtigt wie andere elektrische Gerate Span-
nung zum Arbeiten, und da wir ihn jetzt programmieren
mochten, schliessen wir ihn an den Computer an.

Wenn wir den Arduino mit einem USB-Kabel an einen
Computer anschliessen wird er iiber das Kabel mit den
benotigten 5 Volt versorgt, und wir kénnen loslegen.

Die Software gibts hier:
http://arduino.cc/de/Main/Software

Vorher musst du jedoch noch die kostenlose Software
von obiger Adresse herunterladen und installieren. Die
Arduino Software lauft auf den folgenden gangigen
Plattformen: Mac OSX, Windows und Linux




Wenn du Hilfe benotigst bei der Installation

auf einem Mac:
http://www.arduino.cc/en/Guide/MacOSX

Wenn du Hilfe benotigst bei der Installation

auf einem Windows-PC:

http://www.arduino.cc/en/Guide/Windows
Wenn du Hilfe benétigst bei der Installation

auf einem Linux-System:

http://www.arduino.cc/playground/Learning/Linux

Besuche die obigen Adressen, wenn du detaillierte Anleitungen fiir

die Software-Installation benotigst.
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DIGITAL (PWM~)

Wenn du die Software installiert hast und
der Arduino angeschlossen wurde, sollte eine
mit ON beschriftete LED aufleuchten.

Help

Auto Format
Archive Sketch
Fix Encoding & Reload "
Serial Monitor

®T

~ ~ Arduino Uno 15
o - Arduino Duemilanove w/ ATmegae 28 rmeod
serialPort ‘ Arduino Diecimila or Duerr;nlzasnov
i ATmega
> Arduino Nano w/
mer 28
Born B tloader Arduino Nano w/ ATmeaa o8 ok
— Arduino Mega 2560 or Meg
Arduino Mega (ATmega1238208)
Arduino Mini w/ ATmega

Arduino Mini w/ ATmegal68
Arduino Ethernet

Arduino Fio e ATenana3?8

Nun Starte die Arduino-Software. Im Meni Tools wahle
aus, welches Board du benutzt (Tools > Board). Zum
Beispiel Arduino UNO.

Help
Auto Format
Archive Sketch

Fix Encoding & Reload
Serial Monitor {+3EM

Board
Serial Port

#ET

Programmer

1l Burn Bootloader

/dev/tty.usbmodem1a21
/dev/cu.usbmodem1a21
/dev/tty.Bluetooth-Modem
/dev/cu.Bluetooth—Modem
/dev/tty Bluetaoth-PNA G e

Als ndchstes muss man den seriellen Port auswdhlen

(Tools > Serial Port). Auf einem Mac sucht man z.B.
nach /dev/tty.usbmodem, unter Windows vielleicht

nach COM3. Hadufig ist es der Eintrag, der nach dem
Einstecken des Kabels zur Liste hinzukommt.




Was ist eine
integrierte
Entwicklungs
Umgebung ?

Englisch:
Integrated

Development
Environment

o

Die Software, die du heruntergeladen
hast, ist eine IDE. Das ist ein
Texteditor mit dem man Programme
kompilieren kann sowie weiteren
Funktionen, die es einem erleichtern,
Software zu entwickeln.

Arduino Edit Sketch Tools Help
New ®BN Arduino 1.0
Open... #0
Sketchbook >

Examples

1.Basics | 2 Analo
SClose HEW 2.Digital [ BareM?l
| Save kS 3.Analog I
S on an Ue:)\ga/:js... {r38S 4.Communication [ DigitalR
‘ #U 5.Control P
example Upload Using Programmer ¢ 38U 6.Sensors > | rade
Page Setup 3P 7.Di§play >
Print %p 8.Strings [
ArduinolSP

PLUPO) Do
ntialize the dinital rmiw o on o0
Die Arduino IDE ermaglicht es dir, Sketche, das sind kleine Programme,
zu schreiben und sie auf den Arduino hochzuladen. Offne das Blink -
Beispielprogramm im File-Mendi. File > Examples > 1.Basics > Blink.

Upload-Knopf

ARDUINO

“Done Uploading" zu lesen sein.

Um einen Sketch zum Arduino Mikrocontroller hochzu-
laden klick den Upload-Knopf in der Knopfleiste im
oberen Teil des Fensters. Unten werden einige
Nachrichten erscheinen. Schlussendlich sollte

Die LED am Pin 13 vom Arduino fdngt an zu blinken.




void setup() {

(13, OUTPUT);
}
0 {
(13, HIGH);
(1600);
(13, LOW); // set the LED off
(1600);
}

Ein Sketch ist, genauso wie jedes andere Programm
auch, eine Menge von Anweisungen fiir den Computer.
Wenn wir uns den Blink-Sketch genauer ansehen, so
konnen wir feststellen, dass er aus zwei grofieren
Teilen besteht: setup() und loop().

setup(): Wird einmal ausgefiihrt
beim Programmstart

/; loop(): Wird immer wieder und
/ wieder ausgefihrt

Diese Code-Blocke heissen Funktionen und jeder
Sketch hat welche. Sie werden durch geschweifte
Klammern { } begrenzt.

http://arduino.cc/en/Reference/HomePage

ARDUINO

ey
Refereare Langaage | Libraries | Comvparison | Change |

. 7lr_arrrrgprarge Reference

Besuch' spdter mal die Arduino Webseite um eine
Referenz der Sprache zu sehen sowie viele andere
Resourcen zum Erlernen der Sprache.

void setup() { // Deklariert einen Code-Block
(13, OUTPUT); // Setzt Pin 13 auf Ausgabe
} // Ende des Code-Blocks

() { // Deklariert einen Code-Block

(13, HIGH); // Schaltet Pin 13 an

(1000) ; // Pause fiir eine Sekunde

(13, LOW); // Schaltet Pin 13 ab

(1000); // Pause fiir eine Sekunde

} // Ende des Code-Blocks

Jetzt aber schau dir Zeile fiir Zeile das Skript an und
sehe in den Kommentaren, was jede Zeile macht.
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Aber wie konnen wir Objekte steuern, die nicht auf dem
Arduino sind? Dafiir verbinden wir den Arduino mit
einem l6tfreien Experimentier-Steckbrett. Damit
konnen wir blitzschnell Testschaltungen aufbauen.

Locher untereinander
horizontal verbunden

Lécher untereinander
/ vertikal verbunden

Dieses Steckbrett hat je zwei Reihen mit Lochern auf
der linken und rechten Seite, die vertikal miteinander
verbunden sind sowie fiinf Spalten links und rechts der
kleinen Vertiefung in der Mitte. Diese sind horizontal
miteinander verbunden.

Wir verbinden 5V (Potential/+Pol) und GND (Masse/
Erde) vom Arduino mit den vertikal verbundenen
Streifen links und rechts des Brettes mit 0,7mm
dickem Draht. Elektronische Bauelemente konnen jetzt
an die Locher in der Mitte sowie an 5V und GND

Anode
(an 5V an-
schliessen)
[
Kathode
(an GND an-
schliessen)

angeschlossen werden.

Wenn Strom durch eine LED (Licht emittierende
Diode) in der richtigen Richtung fliesst, dann leuchtet
sie auf. Wir stecken eine LED auf das Experimentier-
brett. Dann legen wir Leitungen zum Arduino, so dass
wir die LED mit Code steuern konnen.




void setup() {
2RBE 5 - pinMode(2, OUTPUT); }

. NI DOTVNY 3

void loop() {
digitalWrite(2, HIGH);
delay(500);
digitalWrite(2, LOW);
delay(500); }
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vhabdN @b In der Funktion setup() konfigurieren wir Pin 2
als Ausgabe. In loop() setzen wir Pin 2 auf

HIGH die LED leuchten ldsst. Del t
Die Anode wird mit Pin 2 am Arduino liber einen 220 Ohm fiir eir'\;,N Sﬁusfvoabssggcmiﬁ's'eiiideaeéysii?

Widerstand verbunden. Die Kathode wird mit GND verbunden. Die Wenn Pin 2 auf LOW gesetzt wird, geht die
Pins 2 bis 13 konnen als digitale Ein- oder Ausgdnge konfiguriert LED aus. Dann folgt eine weitere % Sek. Pause
werden. Klick auf den Neu Knopf um einen neuen Sketch zu machen. ‘ 9 s '

Verify-Knopf

oo g B Upload

Upload-Knopf

Klicke den Verify-Knopf im Mendii, um deinen Code priifen| |Die LED leuchtet fiir eine halbe Sekunde, dann ist sie
zu lassen. Wenn es keine Fehlermeldung gab, klicke auf fiir eine halbe Sekunde aus. So blinkt sie immer wieder
Upload, um dein Programm auf den Arduino zu und wieder.
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Verbinde den einen Kontakt des Tasters mit Pin 4 am Arduino. Den-

Als ndchstes fiigen wir dem Ganzen einen selben Kontakt des Schalters schliessen wir an Erde iber einem 10
digitalen Schalter hinzu, so dass wir die Kilo-Ohm Widerstand an. Die andere Seite des Schalters soll mit
LED An- und Ausschalten konnen. 5V verbunden werden. Die LED lassen wir wo sie ist.

void setup() {

(2, OUTPUT);
(4, INPUT);
}
() {
( (4)){
(2, HIGH);
} {
(2, LOW);
}
}

Jetzt schreiben wir den Code. In Setup definieren wir
Pin 2 als Output und Pin 4 als Input. Im Loop benutzen
wir eine if-Anweisung, eine Bedingung. Wenn das Signal
an 4 HIGH ist, setzen wir den LED-Pin HIGH, ansonsten
setzen wir ihn auf LOW und schalten die LED somit ab.
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Die LED leuchtet, wenn der Schalter gedriickt wird.




Ein Potentiometer, auch Poti
genannt, ist ein verdnderlicher
Widerstand. Die Grofle des
Widerstandes wird groBer oder
kleiner je nachdem in welche
Richtung er gedreht
wird.
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Lass uns mal ein analoges Eingabegerdt
ausprobieren, das Potentiometer.

Schliesse den mittleren Pin des Potis an den Analogpin AO an. Die anderen
Anschliisse des Potentiometers miissen auf GND und 5V gelegt werden.
So gibt der Mittelpin Teilspannungen zwischen O und 5V aus.

void setup() {
Serial.begin(9600);

}

void lLoop() {
Serial.println(analogRead(A0));

}

Erstmal sehen wir uns die unterschiedlichen Werte, die
wir durch das Drehen des Potis erhalten, mit Hilfe des
Seriellen Monitors an. Im Code initialisieren wir dafiir
die serielle Schnittstelle und setzen sie auf eine
Geschwindigkeit von 9600 Baud. Im loop lesen wir den
Wert von Analog Pin AO und geben ihn zur Ausgabe an
die Serielle Schnittstelle mit der printin - Funkftion.

128

129 Klicken um den seriellen
13@ . .o

131 Monitor zu 6ffnen

131

132

133

Nachdem du den Sketch auf den Arduino hochgeladen
hast, klicke auf den Knopf fiir den Seriellen Monitor um
die Werte sehen zu kdonnen. Ein Fenster wird sich
offnen und du wirst Werte von O bis 1023 sehen, je
nach dem wohin du das Potentiometer gedreht hast.




N3-13534

ONINQYY mmm x4
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0% Duty Cycle - analogWrite(0)
o | |

ov

50% Duty Cycle - analogWrite(127)
5v r
ov
100% Duty Cycle - analogWrite(255)

5v
ol | |

Wir konnten die wechselnden Werte, die wir vom Poti empfangen,
nutzen, um eine LED zu dimmen. Steck die LED zuriick ins Brett

und verbinde sie mit dem Arduino iber Pin 3.

Wir werden die PulsWeitenModulation
nutzen, um Analogspannungen zu simulieren.
Durch das An- und Abschalten der
Spannung mit unterschiedlichen Perioden
kann die LED 0-100% der Zeit an sein. PWM
funktioniert auf Pins 3,5, 6,9, 10 und 11

int sensorValue = 0;

void setup() {
(3,0UTPUT);

}

() {
sensorValue (AQ);

(3, sensorValue/4);

}

Zundchst erstellen wir eine Variable, um den Wert des
Potis zu speichern. In setup konfigurieren wir Pin 3 fiir
Ausgabe. In loop speichern wir den Wert, den wir von
AOQ gelesen haben, in unserer Variable. Dann schreiben
wir den Wert auf Pin 3 (LED), miissen ihn vorher aber
noch durch 4 teilen, damit er zwischen O und 255 liegt.
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Die Helligkeit der LED ldsst sich jetzt von komplett
aus bis sehr hell dndern, je nach dem wie du den Poti

einstellst.




Das war eine kurze
Einfihrung in die
Mikrocontroller-

programmierung mit

Arduino. Besuch die Links

in den ndchsten Kdsten

und du wirst noch viel
mehr erfahren.

Links

Software

Software Download
http://www.arduino.cc/en/Main/Software

Referenz der Sprache
http://arduino.cc/en/Reference/HomePage
Bezugsquellen

Distributorenliste
http://arduino.cc/en/Main/Buy

TinkerSoup
http://www.tinkersoup.de/index.php?cPath=22

Watterott
http://www.watterott.com/de/Boards-Kits/Arduino

Elektronikladen
http://elmicro.com/de/arduino.html

Tutorials

Arduino Tutorials
www.arduino.cc/playground/Deutsch/HomePage

Lady Ada
www.freeduino.de/books/arduino-tutorial-lady-ada

Mehr Deutsche Tutorials
www.freeduino.de/books/

Blicher

Die elektronische Welt mit Arduino entdecken
Erik Bartmannn

Arduino - Physical Computing fiir Bastler, Designer
und Geeks Verlag: O'Reilly

Make: Elektronik: Lernen durch Entdecken
Charles Platt
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